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CREATE AN APPLICATION IN ECERT (BASIC VERSION)

For assistance in setting up the account, please see the document ‘eCert Account Setup’.

Log in to eCert, from https://www.ecert.sgs.com/uk/my-ecert

Click on to ‘New Application’

Quick Links
fa

New Application

Or ‘New’

Applications m

View All

Fill in your reference for the application, then click ‘OK’.

Select the country of destination. This will show you which certificates are applicable for that
country, any not applicable will be greyed out.


https://www.ecert.sgs.com/uk/my-ecert

Destination Country: France ~

Choose Documents

==

UK Certificate of Qrigin ATA Carnet

Invoice generated International Import
in eCert Certificate

*

Upload your own
invoice/documents

Click the certificate you wish to use, in this case, UK Certificate of Origin. You can also create an
invoice within eCert or elect to upload your own documents from this window.

Click ‘Next’ then select how many copies you wish to receive of the certificate.

Number of Copies

UK Certificate of Origin Copies

Stationery Required: D

Certified 3 Part Set
No. of original forms required: = 1 <

No. of yellow forms required: = 1 <

Certified & Legalised 3 Part Set
No. of original forms required: = 0 <+

No. of yellow forms required: = 0 <+

You can choose Certified 3 part and/or certified legalized documents from here. Check with your
Chamber of Commerce what you need for this selection.



Click ‘Next’ then select the signatory. The signature will need to be both on the eCert system and
advised to the Chamber of Commerce.

Signature: Jeff Harrison v

(ﬁff t%/‘/‘/ko/(

Click ‘Save’ in the top right.

 Save

(<]

You will then be presented with a graphical representation of the Certificate of Origin, or whichever
certificate you have elected to use. On the left you will see a tree, showing the various sections of
the certificate that are required to be filled.



65% Complete

© Setup [+] v
|
K UKCofO [-] Preview &

Box 1 Consignor

Box 2 Consignes

Box 3 Country of Origin
Box 4 Transport Details
Box 5 Remarks

Box 6 Marks and Numbers
Box 6 Description of Goods
Box & Free Text

Box 7 Quanfities

Box & Place

Box 9 Applicant

Reverse - Origin Declaration
Reverse - Manufacturers

LRLAXR XL XL

Additional Requirements

Supporiing Evidence

x

% Uploaded Documents [+] x

Fill in the required sections, taking advice from the information boxes (in blue) on the right of the
window.

Box 2 - Consignee

Please enter the name and address of the overseas consignee. Under some
circumstances, if the consignee is not yet known, 'To Order for shipment to..."
can be entered followed by the country of destination. Evidence containing a
clear declaration of the destination will be required.

Move over a field for more help.
Consignee Reference

This is normally the Account Number for the Consignee ("Ship to" or "delivery"
address) This field will appear on any <b=browse screens</b> where you
have the ability to view a list of consignees on the system.

This may be the same as the Reference for the buyer if the buyer and
consignee addresses are the same, however, if there are several consignee
addresses for one buyer, each will require a unigue reference.

Below is how it looks when all relevant sections are completed.



100% Complete

O Setup [+]
1
I UKCofO [-] Preview
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Box 1 Consignor

Box 2 Consignee

Box 3 Country of Origin
Box 4 Transport Details
Box 5 Remarks

Box 6 Marks and Numbers
Box & Descripfion of Goods
Buox & Free Text

Box 7 Quanfifies

Box 3 Place

Box 9 Applicant

Reverse - Origin Declaration
Reverse - Manufacturers

LA <L €K<

Additional Requirements

4

Supporting Evidence

% Uploaded Documents [+] LY

It is strongly recommended that all regular entries are stored within the eCert system under Stored
Data, to prevent repetitive typing. VAT numbers etc. can also be stored here.

As you fill in the details you will be offered to save the information to the relevant Stored Data table.

Complete the sections as required, making sure that all of the sections on the tree have green ticks
as opposed to red crosses.

When completing the Description of Goods you will need to complete the entry for ‘Invoice’. Click
‘Add’ once you have entered the details.

When finished, use ‘Checkout’.

Select the way you wish to submit the application to the Chamber, either Standard or eXpress.

Please note: The eXpress service will require you to have pre-printed certificates supplied solely
by your Chamber.

Once submitted to the Chamber, you will no longer be able to amend the application in any way. The
certificate becomes locked to prevent any fraudulent activity, so double check the application before
submitting.



As you go through the Checkout process, you will be asked for the Payment Method, from the drop
down:

Payment Method

Payment Method: Please select 2 Payment Method ~

plus the Shipment Invoice Total.

Shipment Invoice Total: 8.0

By ficking the bax below, | confirm the information given on my application is correct to the best of my abilty. | understand that my appiication will print as it appears in preview and that eXpress applications cannot be
changed by my chamber once they have been submitted. | may be charged a rejection fee, based on my chambers fees and charges, If my application is incarrect

O ‘Confirm

Receive email nofifications for this application (remove the tick from the box fo stop all notifications for this application)

Email Mofification

This is the value of the goods you are shipping, so not inclusive of the charges from the Chamber of
Commerce.

Ensure both boxes on the right contain a tick.

Il print as it appears in preview and that eXpress
lication is incorrect

Confirm

Email Nofification

If you have queries about the progress on any submitted application, please contact your Chamber
of Commerce.

Click on to ‘Contact ******** Chamber of Commerce’ in the top right of the eCert window which
will reveal the telephone number and contact email address.



Frequently Asked Questions

We have included the most frequently asked questions relating to the
use of eCert.

What is eCert? What can | do with it?

eCert is the original online Certificate of Origin (C of O) document certification system, helping both importers and
Chambers of Commerce to work efficiently and securely. Since its introduction in 1999 eCert has served and
worked with the British Chambers of Commerce to improve accuracy and quality of certified documents whilst
minimising delays.

No longer does certified documentation need to be typewritten and stamped by hand, allowing the advantage of
using eCert's Standard and eXpress services to pick up your approved documents at the Chamber, returned via
post, or returned electronically so you can print them at your own workplace (eXpress only).

How do | get started? And where can | go for help?

To get started head over to the Chamber Directory page which can be found on https://www.ecert.sgs.com/uk/

ABOUTUS

CHAMBER DIRECTORY

CERTIFICATE VALIDATION

OW ECERT WORKS

KNOWLEDGE BASE

FEEDBACK

ATA CARNET

eXpress Service


https://www.ecert.sgs.com/about-us/chamber-directory

and select the Chamber you wish to sign up with.

Hover over the chosen Chamber then click the third icon, Create an Account

This takes you to a sign-up page.

Fill in the relevant information in each field, remembering to put a tick in ‘| accept Terms & Conditions:* which
can be read by clicking on the eCert Terms and Conditions link beneath the tick box.

| Accept Terms & Conditions:®

U

eCert Terms and Conditions

The Chamber will require a Formal Undertaking to be completed in order for you to obtain certified documents.

Tip: As a customer of theirs, the Chamber of Commerce is your main contact should you require help.




| have not received confirmation of my login credentials by email — why
IS this?

Your inbox may have suspected the email from us was junk mail and as such we advise you check any
junk/spam folders for the mail containing your password. We recommend you add sgs.com to the allow list within
your email application. This will ensure you have no trouble receiving emails from us in future.

Tip: Make sure you can receive emails from sgs.com as email notifications of accepted and rejected applications
are sent to you from this address.

How can | change my password to something | can easily remember?

1. Loginto eCert.
2. Goto ‘My eCert’ > ‘Change Password’ from the toolbar. Enter and confirm your new password.

Tip: Remember, your account holds confidential information about you and your company. Adding numbers,
symbols and mixed-case letters makes it harder to guess or crack your password.

| have forgotten my password, how do | go about regaining access?

1. Go tothe Password Reset page of eCert.

2. Enter your email address and click ‘Submit’.

3. Check your email inbox for your new password.
It may take a few minutes for the password reset email to arrive. If you do not receive the email within 5
minutes, check your junk/spam folders.

Tip: Copy and paste your email address and password from the email to guarantee an exact match.



https://www.ecert.sgs.com/
https://www.ecert.sgs.com/

Where can | upload signatures?

Administrators can add signatures as per the following instructions

1. Log into eCert.
2. Sign in to your eCert account from your chosen chamber page. If you are having trouble

finding it, hover your cursor over ‘My eCert’ on the toolbar, you should see your chamber at the

bottom of the list.

3. Once you have signed in to eCert from your chamber's page (by choosing ‘Start’ under the

‘Start New Application” area to the right of the screen), click ‘Settings’ on the menu bar.

4. On the ‘Settings’ page you will notice a ‘Signatories’ tab. Click this and next the ‘New’ button to

load a pop-up for adding signatures.

What is a Company Authorisation?

The Formal Undertaking (also known as a Letter of Waiver) is a document that is a company authorisation that

must be signed and provided to the Chamber of Commerce for them to approve your international trade
documentation. Your chosen Chamber will be able to answer any questions you have related to this.

Tip: You are entitled to add signatures of all employees who may, at some point in time, use eCert to sign
certificates. This will save having to update the company authorisation document during the year.

How can | add users to our account?

Administrators can add users to an account as per the following instructions:
1. Login and launch eCert.
2. Click ‘My Account’ in the top-right corner. You will see a link to ‘Add Users’ - click this.
3. Fillin the fields below as follows:
=  Enter the users; Email Address, Full Name and User Role.
4. Click ‘Confirm’.
If the user is not already registered they will receive an automatic email containing their password.

Tip: We recommend having two or more administrators per account. If your main administrator is away

you will therefore still be able to make account changes.



https://www.ecert.sgs.com/
https://www.ecert.sgs.com/

My company details have changed; can this be amended in eCert?

Yes, administrators can amend company y details as per the following instructions:

1. Log into eCert.

2. Click ‘Start’ on your Chamber of Commerce's eCert page and next go to ‘My Account’ in the
top-right corner. You will see a link to ‘View / Update Details’ - click this.

3.  Amend the necessary fields and click ‘Confirm Changes’.

Tip: If company email addresses have changed they can be amended by using the ‘Edit/Remove Users’ page
You may also wish to update any exporter addresses you have added to the database by going to ‘Stored Data’
> ‘Exporters’ within the eCert application.

My email address has changed, how can | update it in eCert?

1. Loginto eCert.

2. Click 'Start' on your Chamber of Commerce's eCert page and next go to 'My Account' in the
top-right corner. You will see a link to 'Change Username' - click this.

3. Enter the new email address you wish to use and click ‘Confirm Changes’.

4. A verification email will be sent to your new email address for confirmation. Once confirmed
your email address will be updated.

Tip: Your email address won’t be changed until you have verified the new address.

| no longer have access to the email address | registered to use on
eCert. What options do | have?

If you have an active account with a Chamber of Commerce we recommend you speak with an administrator on
your account who will be able to add your new email address as a new user. If there are no administrators you
can speak to, email support.ecert@sgs.com stating your request. To add you we need to know

Your full name
Your company email address

Your job title



https://www.ecert.sgs.com/
https://www.ecert.sgs.com/
mailto:support.ecert@sgs.com

What is the difference between a Standard User and an Administrator?

Administrators can make account changes on their account via the My Account button in the top-right
corner. Account changes may include; adding/removing users on the account, modifying account details
and user permissions. It should be noted only administrators can add signatories within eCert itself.

Standard Users can use the system to create certificate applications but are unable to make account
changes or add signatories.

Tip: We recommend having two or more administrators per account. If your main administrator is away you will
still be able to make account changes.

How can | complete an application if the person in our company that
uses eCert is away?

Contact your Chamber of Commerce and ensure you are on your company’s Formal Undertaking. Once
authorised that Chamber will be happy to accept applications in your name. If no administrator is available to add
you to the account then a member of management at your company should email support.ecert@sgs.com stating
your request. To add you to the account we will need to know:

Your full name, Company email address, Job title

If you request to be a Standard User it will be necessary that an administrator has already added your signature
to eCert.



mailto:support.ecert@sgs.com

How do | create another Account?

Log into eCert.

Hover your mouse over 'My eCert' on the menu and click 'New Company Account'

Select ‘Create a NEW Exporter Account’ and fill in the details below. You will need to select

your own Chamber and fill out fields marked with an asterisk (*).

4. Accept the Terms and Conditions, and click ‘Submit’.

5. Your Chamber will be notified of the new account, and you will receive an email of
confirmation.

6. You will next need to provide a formal undertaking to the Chamber. You can do so by hovering

over ‘My eCert’ from the toolbar, then select ‘Company Authorisation’ to take you to the page

to download the authorisation document.

wN e

| Tip: You will still be able to log in to both accounts with the same username and password.

My company is part of a chain. Can each user have access to see the
applications from all sites?

You may wish to provide access to users by adding them to the separate accounts (see ‘How do | add users to
our account?). This option gives users control over the applications they view and in effect eCert can be used as
an archive tool for the applications already created.

Tip: A signature must be provided on the company authorisation document at the chamber if any users
intend to submit applications. A signature does not need to be added for users who browse only.

| have made a mistake on my application. How can | amend it?

Once the document has been submitted for approval it has been finalised as your submission to the Chamber of
Commerce and therefore no edits can be made. You will need to copy the existing application, amend it and re-
submit as a new application. You can do this by hovering over the application in your application list and clicking
the ‘Copy Application’ button, or using the Copy button:

L W— MU W, S


https://www.ecert.sgs.com/

What format can | upload documents in? What is the size limit for the
files?

You can upload documents to eCert in PDF, Microsoft Office and standard image formats. The maximum file
size is 4 megabytes (4mb) and the maximum total file size for all uploads is 10mb’s.

Tip: If a scanned file is too large try re-scanning at a lower resolution. This reduces the file size.

Why is there a barcode on my application?

The barcode is called a Quick Response, or QR, code. QR codes are different from conventional barcodes that
you find in supermarkets or shops. They can be scanned vertically or horizontally by smartphones or dedicated
QR reading devices. Scanning the QR code on your application will forward you to the Certification Validation
page, (www.ecert.sgs.com > Certificate Validation) which can be used to verify the document. Since the
introduction of QR codes, fraudulent certificates have been identified and stopped as overseas parties found the
origin and goods to be different from the certificate issued by Chambers.

Tip: If you have a smartphone you can obtain a QR code reading app and test the system.

Who is responsible for uploading signatures?

Your account administrators are responsible for uploading signatures to your account. Should you not know who
your administrators are your Chamber of Commerce should be able to advise you.

Does my signature need to be updated if my name has changed?

Yes, your signature must be updated so it matches the email address and full name of the user submitting the
application in question. Your company authorisation should also be updated to show this information at the
Chamber.


http://www.ecert.sgs.com/

Why is some of the page cut off at the bottom?

If your prints are being cut at the bottom of the page it would suggest you may have the paper size set to ‘Letter’
or similar under your printer preferences. You can amend this by going in to the control panel, locating your
printer, right clicking it and selecting ‘Printing Preferences’. A preferences window should open, select the
‘Paper/Quality’ tab(this could be labelled differently on your printer). Change the paper size to A4.

Tip: You are printing on to a certificate that will be checked at various docks and ports for validity. We therefore
recommend printing in the highest quality to ensure it is legible. Take some time to look over your application
before it is submitted to the Chamber.

Why does ‘DRAFT’ appear on my document?

This occurs when you are either printing the document before submitting it to the Chamber or printing it as a
‘Trial’ print. Once the Chamber has approved the document you have the option to print by ‘Trial Print’ (useful to
align the boxes on a blank piece of paper prior to printing on an actual certificate), or printing on the certificate as
a ‘Final Print’.

| am having trouble opening a .pdf file. What could be the issue?

We recommend using Adobe Reader for printing .pdf files. If Adobe Reader is not installed on your computer you
will be unable to correctly open .pdf files and your computer may inform you in a dialogue box that the file is not
in a recognisable format. You can download Adobe Reader for free from https://get.adobe.com/uk/reader/ Click
Download Adobe Reader and install it.

Should you already have Adobe Reader installed but are still having problems, it may mean the .pdf is trying to
open in another program. Locate a .pdf file on your computer, right click it and select ‘Open with’>’Choose
default program’ This should produce a pop-up window where you should be able to see ‘Adobe Reader'. Itis
recommended to tick the box that says ‘Always use the selected program to open this kind of file’.

Tip: You may wish to set your browser to automatically open .pdf files for a better workflow.

Why does my print appear to be out of scale when using Adobe Reader?

We recommend setting up Adobe Reader to ensure the alignment of the document is as you see on-screen. You
can do this by opening your document in Adobe Reader, selecting ‘Fil’ > ‘Print’ from the toolbar and applying
‘Actual Size’ under ‘Page Sizing & Handling’. If your version of Adobe Reader does not show this option you can
set the ‘Custom Scale’ to “100%’



https://get.adobe.com/uk/reader/

Is my email address tied to exporter accounts or Chambers?

No, your eCert registration (email address) is not tied to any given exporter account or any given Chamber. If
you need to do so you can register more than one company with more than one Chamber. If you need to create
another account, please find instructions on how to do this by viewing ‘How can | create another account?’.

| have created an account with the wrong Chamber of Commerce. How
do I change it?

You will need to inform the Chamber you did not intend to create an account with them. They will then try to
remove the account and ensure you are no longer linked with that Chamber.

Tip: You can have more than one account with more than one Chamber.

What is the difference between the Standard and eXpress service?

Standard is to be used if the documents are to be printed at the issuing body and either picked up or returned by
post. Legalised documents must be posted to the embassies and therefore can only be sent as Standard.

If you are unsure about which to use, please contact your Chamber of Commerce.

We hope this helps to answer your queries about using eCert. If you have any further queries about the
software, please email us on support.ecert@sgs.com or use the Live Chat facility within eCert.

Any queries relating to how to create the applications themselves need to be addressed to your Chamber of
Commerce.


mailto:support.ecert@sgs.com

How to find your Chamber of Commerce Contact details

In the top right corner, you will see a link labelled
‘Contact Chamber of Commerce’ this will open a contact
details box for your chosen Chamber.

It will display your chosen Chamber when you signed
up.

New Application

'est

&
Add User

&
My Account

When this box pops up, you will see
various contact details appear.

Telephone number

Email Address

Street Address

kA
Upload Signature

&
Formal Underaking

=
Log Cut

Contact Details - Bristol Chamber of Commerce

Telephone Number 01275 373373
Email Address: ezcert@businesswest.co.uk (send email)

Address: Bristol Chamber of Commerce
Leigh Court Business Centre
Abbots Leigh
Bristol
Naorth Somerset
BS58 3RA




How to add a new Company Account (1)

Once signed in to eCert, select New Company
Account from the My eCert drop down menu.

ONIC

SERVICE

ATA CARNET CHAMBER DIRECTORY CHAMBER SERVICES EXPORT DOCUMENTS

Select Create a New Exporter
Account or Join an Existing
Exporter account.

Join an Existing Exporter

account means you know the
email address and company
name so you can join. If not,
you will need to contact an
admin for that account.

Account Setup Setup Help

Account Setup

New or Existing?



How to add a new Company Account (2)

When you create a new Company Account, it

will ask for these details to enter.

Account Setup
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account, you will need to know the =

Do yous movw the Email address of the person that administers your eCert exporter company acoount?
¥ees | Knaw the Email Address:
.

Company name and the

Administrator for that account. They
will receive this through email and
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How to add a New User

Click My Account in the top right corner

d

© Contact Demasstratan Cramter of Commencs | Tumip Tech

_ Auick Links

L] k3
~ e Apphcata Ui Sigrat
-hamber of o ppecncn || Upiea e
& &
A Uiser Formal Lindenakng
& ]
by Account Log Owid

you ane able i submit using the sxpress
e arm et Slaoves nile T s b

#Cen - Account Links

Click Add User in any of these two
areas.

Back 10 eCent

eCert - Account

Add User

Add Now Account

Update Accoun! Detalls »
Email Address: -
II | Changs Chambar »
Fuall Nama: = Addd Usar ¥
I |
User Rola: \
| Proase seisct ! \
Rucatve Formal Underiaking sxpiry smalt: (J \ Enter the Email Address, Full Name and the

\ User Role you wish to grant this new User.
“ "______"“———- You will need to click Confirm to add the user
to the account.
4= Back to my Account




How to add a Signature

Hover your mouse over the Settings button,
and then click Signatories.

= SRCERT  ove

I o . Click New to add a new signatory to the e P S
Account.

Welcome to

Enter Name and Job Title and then click Upload Signature Image. You will then need

to find the file with the signature in such as a PDF, IPG or PNG.
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Once finished
click the ‘Upload
Signature Image

and check it is in
your list of
Signatories.

Once the file has uploaded to eCert,
it will look like this, you will need to
click inside the window and drag a
box using your mouse around the

signature like | have done here, you
can see a mini preview in the
window above.

B Lo sigrse wage

You may wish to increase/decrease DR | Cr Ao o —
the contrast if the scan of the

signature is too faint. :;'" ) 5 ?E 2




How to change Password

Click My Account in the top right corner.

@ Contact Demenstration Chambss of Commerce | Tumip Tech

rce Quick Links
1] <
~ MNew Application Upload Signature
-hamber of
&+ e
Add User Formal Undertaking
& =
My Account Log Out

'YOU A able 10 Submit USing the exXpress
its are issued. Please nole this requires you

My Profile

Click ‘Change Password'

My Services >
Change Password >
Change Password View / Update Details >
Change Username >

Enter New Password:

Confirm New Password: *

Enter a new password for this user.
Capital Letters or Special Characters such as | or

S are recommended.

Confirm the password for the change to take
place. You can click the tick box to make sure

Confirr Changes the password is correct before proceeding.

€ Back to my Account




How to change a User Role

Click My Account in the top right corner.

© Contact Demanstrabon Chambes of Commerce | Turmip Tech

Quick Links )
#Cart - Account
] F
New Application Upload Signature
& e
Add Uiser Formal Uinderiaking
- iC 3
My Account Log Oud Add New Account ¥
Update Account Datalls >
Changa Charmibar 3
Add Usar »
Click Edit/ Remowve Users.
Edit/ Remove Useds >

Edit Account Users

Click the User Group drop down menu,

In here you can change the user group to
Search: | Standard or Administrator. Depending on the
user, you can limit the capabilities that user has
by selecting Standard, Administrator has no

adam@brambleditch.co.uk
Adam

restrictions.

User Group:

Standard v
Standard

Administrator




How to change Username

._.J Live Chat
© Contact Demonstralion Chamber of Commerce | Turnip Tech
Click ‘My Account’ in the top right-
Links hand comner.
k X
+ Application Upload Signature
& e
wd User Formal Undertaking
My Services
- [C]
y Account Log Out Change Password
View / Update Details
@il Qe ENCANT G ——— . Change Usemame
eCert - Account Links
&+ =
Add User Switch Account
¢ ] + €
Change Username b 4 Add New
M Back to aCen
Change your user name

Edit your usemname / email, then venfication will ba sant 1o this
address. The changes must be verified before they take effect.

Username | email: -

II I \
to use, once you click ‘Confirm
* Changes' an automatically

generated email will be sent to you
€ Back to my Account with your new details.

Enter the new Username you wish




How to clear browsing history (Chrome)

- Click the button, and then click

New tsh CueT S
Mew window CrlsM

Settings.
Mew incognito wandonw  Cirl+ Shift=

Higtory
Downloads
Bookmarks
Ioam - 100N
Print... CerleP
Cast...
Fird...
Muare iosls

Cirl=F

Edit

Help » Privacy and sacurity

Exit Cimar rowsing data

Clrar igtong. cookies, catie and moee

Citai i il o sl i
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Clear browsing data
Basic Advanced
Timamnge [ESRtRaE E In here you will need to
o alov: :
o e bistory tick the relevant box
27 items
[ Cownloadhistory The most common are
I Browsing History, Cached
Cookies and other site data Images, FiIE'E
D From 41 sites g !
Cached images MEEL——// : -
ez theacy 5THY 1A Once ticked, click the
Passwards and other signin data Clear Data button and the
HNane data will now be gone.

Aute-fill form data

o 0O

|




How to clear browsing history (MS Edge)

Click -~ which opens the Edge menu.

Click “Privacy &
Services’

Settings

Click Settings.

Click the drop down
to change the time
range.

Tick which boxes
you wish to clear.

Most common are
Browsing History,
Cookies and Cached
Images and Files.

When finished click
the Clear Now
button.

Favourites

More tools

Seftmgs

¢ Help and feedback

Clear browsing data

Time range

Last hour

+  Browsing history

/  Download history

+ Coolies and other site data

+ Cached images and files




How to clear browsing history (Firefox)

Click gto enter Firefox options.
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How to clear browsing history (MS Internet Explorer)

Click m and then click Internet Options.

Print
File >
Zoom (100%) >
Safety >
Open with Microsoft Edge Ctrl+Shift+E

Add site to Apps

View downloads Ctrl+)
Manage add-ons

F12 Developer Tools

Go to pinned sites

Compatibility View settings

About Internet Explorer

Click Delete and then tick Temporary

Internet/Website files, Cookies or History.
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Click Delete to finish.




How to delete User

Click My Account from the top right of the
page.

© Contact Demonsiraton Chamber of Commerce | Turnip Tech

Quick Links
E £3
Mew Applcation Upicad Sagnature
s =
Add User Formal Undertaling
& £
Wty Acouant Lo Ou

Click Edit/ Remove Users.

Edit Account Users

—

Click Delete User to remove that user from the
account.

eCert Chamber - Account

Update Account Details ¥
Add Usar ¥
Edit/ Remove Users ¥

eCert Chamber - Help & Support

You will see a list of users who can access the
account, once the user you want to delete is
located click the drop down arrow.

User Gioup:
| Standard -

Receive Formal Undertaking expiry email; [

—

Diclete User




How to fix PDF upload error

Find and open the PDF file on your PC. This is With the PDF open, click the Print lcon
usually within Downloads or Documents.

Select the drop-down menu, and select
‘Save as PDF’
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Click Save and then try to re-
upload on eCert.




How to print eXpress certificate

Click the Print icon below.

Trial Print
EC Cartificate of Origin

Margins/ARgnment.
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This will open a Print
Window. In here you can
process a Trial Print, this is
wery useful to check
alignment of text.
Lsing the arrows: to mowe the
text up, down, left or ight.

Click Draft and it will create a
PDF for you to print.

We recommend halding the
plain paper up to some ight
with the pre-printed form to
where the alignment
lands.

Please Mote: Always print
your draft copy onto plain
paper.

The Final Print window
iis when you have
completed the step
above and you are
ready to primt onto:
your pre-printed
stationary.

The Certificate number
is the number on the
pre-printed form which
has been pravided by
your Chamber or
HMRC.

Please check this
number is correct.
not, you will need to

contact your Chamber
of Commerce.

Once your pre-printed
fiorm iz in your printer,
you can dick Print.




How to reset forgotten password

Click on the ‘Forgotten Password?’ link near the
Login button

|
Helio! Welcome"

Create ATA Carnets

Signup Now
Password Reset
This will then pop up, from here you will need
PR to enter your email address.

Remember: Email addresses are case-sensitive.




How to sign in

Click Login at the top of
the page

FAST ELECTRONIC SERVICE

ATA CARNET CHAMBER DIRECTORY CHAMBER SERVICES EXPORT DOCUMENTS

CREATE ELECTRONIC CERTIFICATES OF ORIGIN WITH EASE

Hello! Welcome Enter your email
address and password.

Notice: email address

and passwords are
case-sensitive.

Signup Now




How to update account

Click My Account in the top right corner.

@ Contact Demoreirafion Chamber of Comemerce | Turmip Tech

Quick Links

k4

Few Appicason Upload Sagnature
eCert - Account

& [
A User Farmal Linderaking

3 -]

My Atcount Log Cut

Click Update Account Details
under eCert — Account.

Edit which fields you wish to
change, for example
changing your Company
Name from ‘Test Electronics
Limited’ to ‘Test Electrics
Lid’.

Click Submit once changes
are made for them to be
saved.




